
 
30 

Part 5 : Cite While You Write 
 
EndNote works with Word to easily and quickly cite references, and create a paper with 
properly formatted citations, a bibliography, figures, and tables. 
 
This is all done using the “Cite While You Write” (CWYW) toolbar, which you will see in 
Word once you have installed EndNote on your PC. 
 
 

 
If you cannot find the CWYW toolbar please contact the ITS Service Desk, at: 

its-servicedesk@salford.ac.uk 
- it is possible the EndNote program has not installed correctly on your PC. 
 
 
 

Inserting citations & bibliographies into a document 

 
 
1. Open your EndNote library. 
2. Open your Word document. To practice you might like 

to use some “play” typing like this: 
 
 
 

 

 

  

Click the EndNote X8 tab to see 
the EndNote tools.  

3.  In the document click the place where you wish to place 
a citation in the text. Remember to leave a space between 
the last character and your cursor, and that your citation is 
placed before any punctuation (a comma or full stop).  
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In EndNote: 

 

 

 

 

 

4.  Click once to highlight the 
reference you want to use.  

5.  Click the Insert Citation button. 

6.  You should now see a citation in your text, and the 
first reference in a list at the end of your document. 
 

Not what you were expecting to see?  
EndNote defaults to the ‘Annotated’ referencing style, which includes the 
abstract. To change it go to the Style menu and select the style you want. If it 
is not listed, go to Select Another Style… to see the full list. 
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Temporary citations  

 

 

 

 

 

 

 

 

When you are working on very large document (like a thesis) adding more citations will 
get slower. 
 
 
 
 

 

 

 

 

Writing at home? 

If you want to continue writing at home but you don’t have EndNote on your PC you can 
type in your own temporary citations. You must use curly brackets; type the author’s name 
and year, for example: {johnson, 2010}. 

When you open your Word document on a PC which does have EndNote installed (i.e. 
when you get back to university) the temporary citations you have typed will automatically 
format themselves and the references will be added to your bibliography. 

When you insert your first citation it 
may look like this. The brackets { } 
and # number indicate this is a 
temporary citation. 

To format your citations, click the Instant Formatting 
is Off button and select Turn Instant Formatting On. 

To make it faster go to Convert 
Citations and Bibliography and select 
Convert to Unformatted Citations. 
When you have finished adding your 
citations click the Update Citations and 
Bibliography button to format them.  
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Direct quotations and page numbers 

 
Many referencing styles require that a citation for a direct quote (or one where you have 
only changed the words slightly, for example, to ensure correct grammar) must include 
the page number where you found it. 
 
Page numbers are not required if you have paraphrased a source, however may still wish 
to include them – they will help your reader pinpoint where you found an idea, especially 
in a long work, such as a book or thesis. 
 

 

 

 

 

 

 

Remember that a direct quote should be placed in quotation marks,  or 
indented from both margins if it is longer than two or three lines. 

Click on the citation you wish to 
edit, so that it is highlighted. 

Click the Edit & Manage Citation(s) 
button on the CWYW toolbar. 

Check that the correct 
citation is highlighted. 

Type in the page number(s). You do not need to 
include p. or pp. – EndNote will do this for you. 
Click the OK button. 
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Note: the EndNote templates for many styles are not set to accept page numbers as 
described above. If this is the case with style you have chosen you can still use the Edit & 
Manage Citations button to add a page number, but you will need to type it into the Suffix 
field.  

 

 

Changing the citation format 
 

In your writing you will often integrate the author’s name into your text, for example: 
 
 Gray and Wegner (2012) described the … 
 
In this case, you do not repeat the authors’ names in a citation at the end of the section.  

 

 

 

 

 

The correctly formatted page number 
will now be added to the citation. 

This is a free text field, so you will 
need to type in the punctuation, 
spaces and p. or pp. before the page 
number(s).  

To format your citation this way, place your cursor where you want the 
author’s name to be – usually this will be at the start of your paraphrase. 

Insert the citation in the usual way (see pp. 30-31.)  
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There may also be times where you have mentioned both the authors and the date of an 
article in your text, (for example, In his book of 2010, Austin detailed the ….)  and therefore 
do not need either in your citation. You do still need the reference in your bibliography, 
and you should use EndNote to insert this. 
 

 

 

 

Right-click on the citation you have just 
inserted,  
 
go to Edit Citation(s) 
 
and select Display as: Author (Year). 

Your citation will now be correctly formatted, i.e. authors’ names incorporated into the 
sentence, separated with the word ‘and’, and followed by the date in parentheses. 
wording so it forms a grammatically correct sentence. 

Type the year and author into your text. 

Place your cursor where you would normally add the citation, i.e. at the end of the 
sentence.  
Go to EndNote and add the citation in the usual way (see pp. 30-31). 
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Adding multiple citations 

 
There will be times when you have summarised the content of two or more different 
papers into a single sentence or paragraph, and will need to insert a multiple citation. 
 

 

 

Right-click on the citation 
you have just inserted. 

Go to Edit Citation(s), then select 
Show Only in Bibliography. 

The citation will be removed from your text, but the coding remains 
which ensures that the reference will stay in your bibliography. 

In your document, place your cursor 
where you need to put the citation. 
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In EndNote, hold down the <Ctrl> key while you select the references 

you wish to cite, then click the Insert Citation button. 

The multiple citations will be inserted in your document in the correct format – in this case, all 
three articles are enclosed in one set of parentheses, in alphabetical order and separated by 
semicolons. This will vary according to the reference style you have chosen. 

You may wish to add more works to the multiple citation, for example, you have read another 
work that supports your statement. To do this, click anywhere on the citation so that it is 
highlighted, then return to EndNote and use the Insert Citation icon to insert the new citation. 

EndNote will automatically re-sort your citations 
into the correct order – in this case alphabetically. 
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Creating secondary citations 

 
There are times that you will find something referenced in a book or an article that is so 
useful or interesting you want to use it in your own writing. This might be a citation for 
another article, or an illustration, graph or table take from another work. 
 
Generally, you should try to find and read the original work and use that as the source of 
your citation and reference. However, there are times when this isn’t possible, for 
example, you may not be able to get hold of the original work, it is in a language you can’t 
read, or the citing author has summed up the ideas in the original more succinctly or 
elegantly than you could ever manage. 
 
When you use a secondary citation like this, your in-text citation should mention both 
works but your bibliography only includes a reference for the work you have actually read 
yourself. You can use the CWYW tools to format a citation in this way. 
 

 

 

 

 

 

 

 

 

 

 

 

 

For example, you may wish 
to use this idea, attributed 
to Campbell, in an article 
you have read by Drezner. 
 

Insert the citation for the article you have read, then 
click on the citation so that is highlighted then click the 
Edit & Manage Citation(s) button on the toolbar. 
 

Make sure the correct citation 
is highlighted. 
 

In the Prefix field, type in the authors and the year 
for the work you have seen cited plus the words 
such as ‘cited in’. (You should check the exact 
wording required by the style you are using.) 
Remember to leave a space after the last word. 
Click OK. 
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Deleting citations 
 

Because of the large amount of coding behind each citation you 
insert, you cannot simply remove a citation by using the <Delete> 
key.  If you try to do this, you run the risk of leaving a bit of coding 
behind – which will break it. 
 
Nor can you delete a citation you have put in the wrong place by 
using the ‘Undo’ button in Word.  
 
To remove a citation you must use the CWYW tools. 
 

 

Your citation and all its coding will now be removed cleanly from your document. 

This will format the secondary citation and add 
the correct item to your bibliography. 
 

Click on the citation so it is highlighted, then click 
the Edit & Manage Citations button. 
 

Click the arrow on the Edit Reference button, 
and select Remove Citation.  
 

Click the OK button. 
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Inserting images into your document 
 

If you have attached images to your EndNote records (see p. 24)  you can use EndNote to 
insert images and captions into your document. 
 

 
Note: for a large document with several chapters (for example, your thesis) you may prefer 
to insert your images manually and use the Word Caption Tools. There is a great video to 
show you how this is done here: http://media.salford.ac.uk/Play/10355 - and lots more 
useful information about formatting your thesis or dissertation at Skills for Learning: 

http://www.salford.ac.uk/skills-for-learning/home/it-and-digital-skills/dissertations 
 

 
To insert an image into your document first press the <Enter> key once or twice to make a 
space where you want the image to go. 

 

 

 

 

 

 

Click the small arrow in the bottom 
right-hand corner of the Insert Citation 
icon on the EndNote ribbon,  
then select  Insert  Figure from the 
menu. 

A search form will be displayed. Type 
in a keyword (e.g. from the caption 
you gave the image) and click the Find 
button. 

Highlight the one you want 
and click the Insert button. 

A list of matching image references will 
be displayed.  
Click on each one to see a preview.  
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Depending on the bibliographic style you have chosen, the image you have 
just inserted may be displayed in “List of Figures” at the end of your 
document, with a Figure reference in your text – as in these examples. 

 
 
 
 
 
 
 
 
 
 
 
In other bibliographic styles, the image will be displayed in the body of your text. If you 
wish, you can edit your Output Style in EndNote to determine how images are displayed. 
 
Whenever you use illustrations, graphs, tables, etc. in your writing you should explain the 
purpose of them, and cite them as you would for any other literature you have used. For 
more information see the “Referencing Images and Tables” guide, available at: 

www.salford.ac.uk/skills-for-learning/home/using-and-referencing-
information/referencing 

 
You should have separate bibliographies for ‘Lists of Figures’ and ‘Lists of Tables’. EndNote 
doesn’t generate these automatically, so to create them follow the instructions on the 
next page, Exporting  a Bibliography. 
 
Before you export your List of Figures it is a good idea to put them all into a group. You 
can make a Smart Group (see p. 27) as follows: 

 
Give your group a title. 

Select Caption from the first menu, and 
is greater than from the second menu. 

Type a blank space (i.e. press your space bar) 
here, then click the Create button. 

This will file every record with anything in the 
Caption field in the Smart Group.  
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Exporting a bibliography 

 
Sometimes you may wish to use EndNote just to produce a bibliography for you – for 
example, you may prefer to type your in-text citations yourself, or you may wish to create 
a separate list of illustrative material (see above). 
 
This can be done within your EndNote library; the exported bibliography may then be 
copied and pasted into your document. 
 
 

 

 

 

 

1.  Click on All References or the Group 
you want to create your bibliography from 
(e.g. this Group could be for a chapter of 
your thesis or for your images). 

2.  Select the references you want included in the 
bibliography, either by holding the <Ctrl> key while you 
click on them, or by using <Ctrl><A> to select all. 

3.  Click the Export button. 

4.  Click the This PC icon and choose 
where to save your file (e.g. F: drive).  
 

5.  Give your file a name, and select Rich Text 
Format (.rtf) from the Save as type menu.  
 

7.  Click the Save button. 
6.  Select the Output style 
you want from the menu. 
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Some things that might go wrong 

 

Has your Reference List disappeared? 

And are your citations are now in curly brackets with a # number? 

 
Don’t be alarmed.  Your ‘Instant Formatting’ has turned itself off. These are called 
Temporary Citations, and there is more information about them on p. 32. 
 

 

 
 
 

Is your Reference List in a different font? 

You can change the font to match the rest of your document. 

 

 

 

 

 

 

 

 

 

 

Click Instant Formatting is Off and 
select Turn Instant Formatting On. 

Your citations should re-format instantly, but if they 
don’t, click Update Citations and Bibliography. 

Click the little arrow in the corner of 
the Bibliography section. 
Click the Layout tab, then select the 
font and size you need.  (If you are 
writing a PhD thesis this will usually 
be Times New Roman, 12.) 
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Are there initials in your citations? 

 
You may notice that initials, or even given names, are 
appearing in some of your citations.  
 
This is not actually a fault; it is EndNote differentiating 
between ambiguous citations.  

You need to be able to tell which citation matches which reference – this is the whole point 
of referencing. 

 
The appearance of initials 
happens when you have 
works by the same author 
but with their name entered 
differently, or you have 
different authors with the 
same family name. 

 

If you don’t need initials to differentiate citations (for example, the works are from 
different years) you can ask EndNote to stop including them. 

 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

Select the style you want from the menu. 
 

Go to the Edit menu. 
 
 
Select Output Styles, 
 
 
then “Edit APA 6th” (or the name of the 
style you are using). 
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Click the Update Citations and Bibliography button in Word document and the initials will 
be removed.  

  

Click Ambiguous Citations,  
then click to un-tick the Include the author initials … box. 
 

Then click Author Name,  
and click to un-tick the Use initials only … box. 
 
Go to the File menu and use Save or Save As to save the style 
with the same name (e.g. APA 6th.) 
 

Note: in this case, the letters a and b have been added to the citation to distinguish between 
works written by the same person in the same year. EndNote does this for you automatically. 
 


